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Dans cette leçon, vous apprendrez à créer un dessin d'une pièce.

Drafting

Sujets traités :

Etude de cas : Drafting
Objectif de conception
Etapes du processus
Démarrage d'un nouveau dessin
Création de vues
Création de cotes et d'annotations
Création de vues supplémentaires
Modifications de vues
Enregistrement d'un dessin
Impression d'un dessin
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Étude de cas : Drafting

L'étude de cas pour cette leçon est la pièce de base de l'assemblage de la perceuse à
colonne, illustrée ci-dessous. Cette étude de cas se focalise sur l'intégration de l'objectif de 
conception lors de la création d'un dessin de la pièce.
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Objectif de conception

� Le dessin doit être créé en utilisant 
une norme ANSI.

• Les normes définissent des formats 
prédéfinis pour les cotes, les 
annotations et les vues afin d'assurer 
une interprétation cohérente des 
informations.

� Le dessin doit contenir une vue qui 
affiche les lignes cachées et les axes.

• L'affichage des ces entités dans une 
vue simple permet une meilleure 
compréhension du modèle en affichant 
la profondeur et l'intérieur des 
éléments.

� Le dessin doit contenir un cartouche.
• Obligatoire pour tout dessin.

Le dessin de la base doit correspondre aux pré-
requis de l'objectif de conception suivant :
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Etapes du processus

1. Démarrage d'un nouveau dessin.
2. Ajout d'un cartouche.
3. Création de vues.
4. Création des cotes et des annotations.
5. Enregistrement du dessin.
6. Impression du dessin.

Les étapes suivantes seront utilisées pour créer le dessin 
détaillé de la pièce de base :
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Présentation de Generative Drafting

L'environnement 3D donne aux concepteurs un outil très 
efficace et flexible pour créer des pièces et des 
assemblages. Cependant, il est souvent nécessaire de 
convertir ces informations en dessins 2D des composants 
pour indiquer les détails de fabrication.
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Processus général

La création d'un dessin pour des pièces et des 
assemblages peut commencer à tout moment dans 
le processus de conception. CATIA maintient un lien 
associatif entre le dessin et les pièces et 
assemblages associés. Au fur et à mesure que les 
modèles de pièces et d'assemblages 3D évoluent, 
les dessins affichent automatiquement les 
géométries mises à jour.

Part Design Assembly Design

Generative 
Drafting

Sketcher

Lien associatif
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Accès à l'atelier

BC

A. Menu Start (Démarrer)
B. Menu File (Fichier)
C. Icône New (Nouveau)
D. Icône de l'atelier

Les dessins de pièces et d'assemblages sont 
créés dans CATIA en utilisant l'atelier Drafting. 
On peut y accéder de différentes façons : A

D



Principes de base CATIA V5- Leçon 10 : Drafting (ISO)
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            10-8

L'environnement de dessin

A
B

C

D

L'environnement de dessin de l'atelier 
Drafting présente les entités suivantes :

A. Arbre des spécifications
• Contient les informations sur les 

calques et les vues.

B. Sheet (Calque)
• Contient les vues de dessin, le 

cartouche, les annotations, les cotes, 
etc.

• La vue active est soulignée dans 
l'arborescence et encadrée en rouge. 

C. Prompt (Messages)
• Affiche les pré-requis et les 

instructions pour les outils quand ils 
sont activés. Les entrées des lignes 
de commande sont aussi effectuées 
ici.

D. Barre d'outils
• Contiennent les outils de l'atelier 

Drafting.
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Barre d'outils et objets de Drafting

A

B

C

D

E

F

G

H

A. Views (Vues)

B. Drawing (Dessin) 

C. Dimensioning (Dimensionnement)

D. Generation (Génération)

E. Annotations

F. Composants d'habillage

G.Création de la géométrie

H. Modification de la géométrie

Les barres d'outils suivantes sont les plus 
couramment utilisées. La plupart peuvent être 
trouvées à partir de la barre de menus :
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Démarrage d'un nouveau dessin
Dans cette section, vous apprendrez à créer un nouveau dessin.

Suivez ces étapes :

1. Démarrage d'un 
nouveau dessin. 

2. Création de vues.
3. Création des cotes et des 

annotations.
4. Création de vues 

supplémentaires.
5. Modifications de vues.
6. Enregistrement du dessin.
7. Impression du dessin.
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Définition du format et des normes du dessin

A. Standard (Norme)

� Normes ISO, ANSI ou JIS

B. Format du papier

� A, B, C ; ou A0, A1, A2, etc.

C. Orientation 

� Landscape (Paysage) ou Portrait.

Quand un nouveau dessin commence, il vous 
est demandé de définir les propriétés du 
dessin. 

Voici les types de paramètres à votre 
disposition :
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Démarrage d'un dessin avec un calque vide

2

1

1. A partir de l'atelier Part Design, basculez 
dans l'atelier Drafting.

2. Définissez les paramètres du dessin dans 
la fenêtre New Drawing (Nouveau dessin).

3. Cliquez sur OK.

Suivez ces étapes pour créer un nouveau 
dessin vide :
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Propriétés des calques

2

1

Suivez ces étapes pour modifier 
les propriétés d'un calque :
1. Cliquez avec le bouton droit de la souris sur la feuille 

dans l'arbre de spécifications. Cliquez sur Propriétés 
(Propriétés) dans le menu contextuel.

2. Dans la fenêtre Properties (Propriétés), vous pouvez 
effectuer des modifications sur le calque, en entrant des 
valeurs dans les champs Name (Nom), Scale (Echelle), 
et Projection method (Méthode de projection) (ANSI ou 
ISO).
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“File > New from” (Fichier > Créer 
à partir de)

Vous pouvez vous servir de ces fichiers pour 
commencer de nouveaux dessins. Pour ce 
faire, sélectionnez le menu “File > New from”
(Fichier > Créer à partir de). Sélectionnez le 
fichier exemple, renommez le dessin et 
supprimez les éléments existants du dessin. 
Vous pouvez commencer à travailler dans ce 
nouveau fichier.

Il est possible de stocker des exemples de 
fichiers CATDrawing correspondant aux normes 
d'une organisation à un emplacement central. 
Ces fichiers contiennent les informations 
suivantes :
A. Cartouches de l'organisation, pouvant contenir 

des informations du type nom de l'organisation, 
numéro de référence, numéro de révision, etc.

B. Normes de dessin, du type styles de cote, 
types de droite par défaut, couleurs des lignes, 
etc. 

Exemple de nomenclature

Cartouche
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Cartouches de dessin (1/2)

• Vous pouvez manuellement créer un 
modèle de dessin en utilisant les outils de 
géométrie. Vous pouvez alors utiliser le 
modèle comme dessin de démarrage 
pour tous les nouveaux dessins. Cliquez 
sur le menu Fichier > Créer à partir de 
dans la barre de menus pour créer un 
fichier à partir d'un modèle. 

• Vous pouvez entrer des macros 
personnalisées pour générer le 
cartouche. CATIA fournit des modèles de 
cartouche qui peuvent être utilisés 
comme point de départ pour créer des 
cartouches personnalisés pour votre 
société.

• Vous pouvez créer les cartouches en 
insérant un ensemble prédéfini 
d'éléments de dessin à partir d'un 
catalogue 2D. Cet ensemble est appelé
composant 2D.

Les cartouches dans CATIA peuvent être générés 
de trois façons :
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Cartouches de dessin (2/2)

2

3

4

56

1. Cliquez sur le menu Edition > Calque du 
fond pour entrer dans le mode CATIA 
d'édition du cadre et du cartouche.

2. Cliquez sur l'icône Frame Creation (Crée 
le cartouche). La fenêtre Insert Frame 
and Title Block (Insertion du cadre et du 
cartouche) s'ouvre et affiche les styles par 
défaut et les exemples de macro.

3. Sélectionnez le type de cartouche dans la 
liste Style of Titleblock (Style de 
cartouche).

4. Sélectionnez Création dans le champ 
Action.

5. Cliquez sur Apply (Appliquer).

6. Cliquez sur OK.

Suivez ces étapes pour insérer un cartouche 
dans un dessin :
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Bolts

Présentation des catalogues 2D

Composant 2D 
enregistré dans 
un CATDrawing

Instances d'un composant 2D.

Un lien est conservé entre les instances et 
le composant 2D d'origine. Vous pouvez 
mettre à jour les instances de façon à
refléter les modifications apportées au 
composant 2D d'origine. 

Un composant 2D est un ensemble 
réutilisable de géométries et d'annotations. 
Ce composant est enregistré dans un 
CATDrawing présent dans le catalogue. Il 
est possible d'instancier plusieurs fois le 
composant 2D, et chaque instance fournit un 
composant avec une orientation, une 
position et une échelle spécifiques.
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Bolts

La boîte de dialogue 
Catalog Browser 
(Navigateur de 
catalogues) contient la 
liste des chapitres dans 
le fichier de catalogue. 

Un aperçu du 
composant est affiché. 

1

2

4

Pour instancier plusieurs fois un composant 
2D à partir d'un catalogue, réorienter le 
composant et le décomposer au moment de 
l'instanciation, procédez comme suit :

1. Ouvrez la vue dans laquelle vous 
voulez instancier le composant 2D et 
cliquez sur l'icône Navigateur de 
catalogue.

2. Ouvrez le fichier du catalogue source 
à l'aide de l'outil Choisir un autre 
catalogue.

3. Cliquez deux fois sur le chapitre dans 
lequel se trouve le composant 2D.

4. Sélectionnez le composant 2D que 
vous voulez instancier.

Insertion d'éléments à partir d'un catalogue (1/2)
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5

6
8

7

5. Faites glisser le composant du 
Navigateur de catalogue dans la 
fenêtre du dessin et sélectionnez les 
points d'instanciation .

6. Définissez les valeurs d'angle et 
d'échelle.

7. Utilisez les outils à votre disposition 
pour positionner et orienter 
correctement l'instance de composant.

8. Cliquez sur l'espace vide dans le 
calque pour quitter la commande. 

Insertion d'éléments à partir d'un catalogue (2/2)
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Création de vues
Dans cette section, vous apprendrez à créer des vues de dessin élémentaires.

Suivez ces étapes :

1. Démarrage d'un nouveau 
dessin. 

2. Création de vues.
3. Création de cotes et 

d'annotations.
4. Création de vues 

supplémentaires.
5. Modifications de vues.
6. Enregistrement du dessin.
7. Impression du dessin.
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Types de vues

A

B

Deux types de vues peuvent être créés dans CATIA 
:

A. Associatives (c'est-à-dire liées aux modèles 
3D), appelées Vues générées. 

B. Non associatives (c'est-à-dire non liées aux 
modèles 3D), appelées Vues de dessin.

Les vues représentent différentes orientations d'une 
pièce, 
ce qui aide à cerner son objectif de conception.
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Principe d'une vue de face

Principe d'une projection

Plan de 
projection

Vue de face

Pièce 
3D

Vue de face

Une vue de face est une vue de 
projection, obtenue en dessinant la 
perpendiculaire à tous les points des 
arêtes d'une pièce sur le plan de la 
projection. 

Pour créer une vue de face, vous avez besoin de 
trois éléments :

A. Conteneur du dessin : Il s'agit d'un calque 
dans lequel la vue de face est créée.

B. Géométrie 3D : Il peut s'agir d'un corps de 
pièce d'une CATPart ou de composants 
d'un document d'assemblage. Pour créer 
une vue de face, il est nécessaire d'ouvrir 
un document contenant la géométrie 3D 
dans CATIA. 

C. Un plan de projection : Il peut s'agir d'un 
plan ou d'une surface plane d'une pièce.
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Création d'une vue de face (1/2)

2

3

1

1. Démarrez le dessin avec un calque vide.

2. Sélectionnez l'icône Vue de face. 

3. Activez le fichier CATPart en sélectionnant 
le menu Window > Sample.CATPart
(Fenêtre > Sample.CatPart).

Lorsque vous créez des vues individuellement, 
vous créez d'abord une vue de face. Elle peut 
être créée à partir d'une pièce, une sous-partie 
de pièce, un produit, une sous-partie de 
produit. 

Suivez ces étapes pour créer une vue de 
face :



Principes de base CATIA V5- Leçon 10 : Drafting (ISO)
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                          10-24

Création d'une vue de face (2/2)

4

6

5

4. Déplacez le pointeur au-dessus d'un plan 
ou d'une surface plane pour définir la vue 
de face. Un aperçu s'affiche.

5. S'il vous satisfait, sélectionnez la 
référence. CATIA bascule dans l'atelier 
Drafting avec un aperçu de la vue. Vous 
pouvez manipuler et faire pivoter 
l'orientation à l'aide de la boussole. 

6. Cliquez n'importe où
dans le calque du 
dessin pour générer 
la vue.

Suivez ces étapes pour créer une vue de face 
(suite) :
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Utilisation de la boussole (1/3)

• Cliquez sur les flèches haut, bas, gauche et droite pour faire pivoter l'arrière plan de 90 
degrés.

La boussole vous permet de réorienter une vue comme souhaité par l'objectif de conception. 
Cette fonctionnalité n'est disponible que lors de la création de la vue de face.

Vous pouvez effectuer les actions suivantes à l'aide de la boussole :

Clic sur la flèche 
orientée vers le haut 

Clic sur la flèche 
orientée vers la 

droite 

Selon
config.

Selon
config.

Selon
config.
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Utilisation de la boussole (2/3)

Clic sur la 
flèche 

centrale de 
gauche

Selon
config.

• Cliquez sur les flèches centrales gauche et droite 
pour faire pivoter la vue de 30 degrés sur le même 
plan. L'incrément de 30 degrés peut être modifié
dans le menu contextuel qui apparaît en cliquant 
avec le bouton droit sur la boussole.

Vous pouvez effectuer les actions suivantes à
l'aide de la boussole (suite) :
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Utilisation de la boussole (3/3)

Générez la vue

A

B

Selon
config.

• Vous pouvez faire pivoter la vue :

A. En définissant un angle de rotation.

B. Librement, avec la souris.

• Lorsque la définition de la vue est 
achevée, cliquez sur le centre de la 
boussole ou n'importe où dans le calque 
pour générer la vue de face.

Vous pouvez effectuer les actions suivantes à
l'aide de la boussole (suite) :
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�

A propos du plan de projection

Vous pouvez utiliser la surface plane d'une pièce 
pour définir le plan de projection pendant la 
création d'une vue de face. Après la création de 
la vue, aucun lien n'existe entre la face 
sélectionnée dans la pièce 3D et la vue.

La face plane de la pièce est 
utilisée pour définir le plan de 
projection.

Visualisation du 
plan de 
projection

Dans le cas d'une géométrie composée de 
surfaces, qui ne comporte pas de surface plane, 
vous pouvez créer un plan temporaire, définir la 
vue de face et supprimer ensuite le plan.

Plan temporaire

Une fois la vue 
définie, supprimez le 
plan.

La vue de face 
reste inchangée.
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Ajout de vues de projection

1

2

3

1. Sélectionnez l'icône Vue projetée.

2. Placez le pointeur dans la zone du dessin 
où créer la vue. Un aperçu de la vue 
apparaît.

3. Cliquez sur le dessin pour générer la vue.

Après avoir positionné la vue de face initiale, 
vous pouvez ajouter rapidement des vues de 
projection (ex. dessus, dessous, droite et 
gauche) en utilisant la vue de face comme 
référence. 

Suivez ces étapes pour ajouter une vue de 
projection :
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Ajout d'une vue isométrique

3

2

1

1. Sélectionnez l'icône Vue isométrique.
2. Sélectionnez une face sur la pièce dans le 

document pièce ou produit. Un aperçu de 
la vue isométrique apparaît.

3. Cliquez n'importe où dans le dessin pour 
générer la vue.

Suivez ces étapes pour ajouter une vue 
isométrique :
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Assistant 2D

AB

B

A. Des mises en page de vue standard, 
comprenant : 

• Face, dessus, gauche.

• Face, dessous, droite.

• Toutes les vues. 

B. Des mises en page personnalisées, 
comprenant :

• Ajout de vues pour créer une mise en page 
de vues spécifique. 

• Suppression et réorganisation des vues 
comme souhaité.

View Wizard (Assistant 2D) vous permet de 
créer rapidement :
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Génération de vues en utilisant l'assistant 2D (1/3)

2

3

1

4

1. Sélectionnez l'icône Assistant 2D.

2. Sélectionnez l'une des mises en page de vues 
et cliquez sur le bouton Next (Suivant) pour 
afficher des vues supplémentaires.

3. Sélectionnez et positionnez des vues 
supplémentaires (ex. vue isométrique) dans la 
configuration de vues existante. 

4. Cliquez sur Finish (Terminer).

L'assistant 2D vous permet de définir rapidement 
une mise en page de vues en utilisant seulement 
le plan initial ou une surface plane pour définir la 
vue de face. 
Suivez ces étapes pour définir une mise en page 
des vues :
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Génération de vues en utilisant l'assistant 2D (2/3)

5

6

5. Sélectionnez la face sur la pièce 3D qui 
servira de surface d'arrière-plan à la vue 
de face.

6. Un aperçu de votre configuration de vue 
apparaît sur le calque du dessin.

Suivez ces étapes pour définir une mise en 
page des vues (suite) :
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Génération de vues en utilisant l'assistant 2D (3/3)

7

7. Cliquez n'importe où dans le dessin pour générer et 
modifier la position des vues individuelles si 
nécessaire.

Suivez ces étapes pour définir une mise en page des vues (suite) :
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Différents modes de génération de vue
Vous pouvez créer une vue dans un dessin en 
utilisant l'un des modes suivants :
1. Le mode de génération de vue Exact est 

souvent le meilleur choix. Cette option 
permet de générer tous les types de vues. Il 
existe cependant quelques cas où ce mode 
est déconseillé :

a. Dans le cas d'assemblages impliquant de 
grandes quantités de données, la 
génération de vues exactes risque de 
consommer beaucoup de mémoire. 

b. Certains éléments de documents .model
V4 (tels que les dittos, les surfaces, etc.) 
ne sont pas pris en charge. 

2. Les vues CGR sont générées à l'aide du 
format CGR. Ces vues sont pratiques pour la 
gestion d'assemblages volumineux, 
impliquant de grandes quantités de données. 

3. Les vues approximées ne sont pas aussi 
précises que les vues exactes, mais ce mode 
de génération réduit la consommation de 
mémoire. 

4. Les vues en image bitmap sont générées 
comme des images. Elles vous permettent 
de générer rapidement des vues globales 
pour des produits ou assemblages 
volumineux.
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Vues CGR

Utilisez le mode CGR pour créer 
rapidement des vues moins précises 
d'assemblages volumineux, ouvertes en 
mode visualisation. 

Les vues CGR sont générées à l'aide du format 
CGR (CATIA Graphical Representation). Un format 
CGR ne contient qu'une représentation graphique 
de la géométrie, qui est disponible avec le mode 
visualisation. 
Avantages des vues CGR :

1. Les vues CGR optimisent la mémoire lors de la 
génération et de la gestion de vues de projection pour 
des produits ou des assemblages volumineux. 

2. Elles génèrent des vues à partir de données de tiers 
ou d'éléments polyédriques (tels que dittos, surfaces, 
etc.) dans des documents .model V4. 

Inconvénients des vues CGR :

1. La qualité des vues CGR est inférieure à celle des vues 
exactes. 

2. Vous ne pouvez pas projeter d'éléments 3D tels que des 
éléments filaires, points, etc. dans des vues CGR.

3. Vous ne pouvez pas créer les types de vues suivants à
l'aide du mode CGR :

a. vues de section
b. vues détaillées
c. vues écorchées
d. vues dépliées
e. vues 3D
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Quels seront les éléments projetés ?

Le type d'éléments 3D projetés dans une vue 
dépend du type de vue et du mode de génération 
de vue.

De façon très générale, en cas de création de 
projections à partir de l'espace 3D en mode 
Exact, tous les éléments d'une CATPart (solide 
3D et géométrie filaire 3D) seront générés, du 
moment que les options suivantes sont définies :

Sélectionnez cette option pour 
projeter des éléments filaires 3D, 
comme des droites, des courbes

Sélectionnez cette 
option pour 
projeter des points 
3D.

Lors de la création d'une vue de projection à
partir d'un modèle CATIA V4, un solide exact 
(SolidE), une peau (*SKI) et des faces (*FAC) 
sont projetés. Les autres éléments tels que les 
surfaces, les volumes et les éléments filaires 
(*SUR, *VOL, *CRV, *CCV, *LN, *PT, *CPT, 
*PLN, *POL) ne sont pas projetés.
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Création de cotes et d'annotations
Dans cette section, vous apprendrez à créer des cotes et des annotations.

Suivez ces étapes :

1. Démarrage d'un nouveau 
dessin. 

2. Création de vues.
3. Création de cotes et 

d'annotations.
4. Création de vues

supplémentaires.
5. Modifications de vues.
6. Enregistrement du dessin.
7. Impression du dessin.
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Création de cotes

Les cotes définissent la taille et l'objectif 
fonctionnel d'une pièce, elles sont souvent utilisées 
pour créer un dessin de fabrication pour un 
fabricant.



Principes de base CATIA V5- Leçon 10 : Drafting (ISO)
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                          10-40

Système de cotes 
A

B

C

C

B

A

A. Chaînée

B. Cumulée

C. Empilée

En utilisant la barre d'outils Dimensions 
(Cotes), vous pouvez créer les types de 
système de cote suivants :
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Types de positionneurs de cotes (1/2)

Position du
curseur

Position du
curseur

Position du
curseur

A

B

Barre d'outils Tools Palette 
(Palette d'outils).

A B C D E F G

A. Cote projetée
• La position du pointeur détermine la cote qui sera 

créée.

B. Cote forcée sur un élément
• Quelle que soit la position du pointeur, la cote est 

imposée parallèlement à l'objet sélectionné.

Pour ajouter des cotes manuelles, il est possible, 
en fonction de la géométrie, d'utiliser plusieurs 
types de cotes pour décrire la même entité. 
Lorsqu'une icône de cote manuelle est 
sélectionnée, la barre d'outils Tools Palette 
(Palette d'outils) apparaît pour préciser le type 
de cote à créer.

CATIA vous permet de positionner les cotes 
manuelles au moyen des outils de 
positionnement suivants :
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Types de positionneurs de cotes (2/2)

C

D

F

E

G

C. Cote forcée horizontalement
• Quelle que soit la position du curseur, la cote 

est forcée horizontalement par rapport à l'objet 
sélectionné.

D. Cote forcée verticalement
• Quelle que soit la position du curseur, la cote 

est forcée verticalement par rapport à l'objet 
sélectionné.

E. Cote forcée suivant une direction
• Place la cote par rapport à d'autres entités.

F. Cote vraie grandeur
• Quelle que soit l'orientation de la vue, la cote 

représente la longueur exacte de l'élément 3D 
sélectionné.

G. Détection de points d'épure
• L'outil crée une cote basée sur l'intersection 

d'une géométrie.

CATIA vous permet de positionner les cotes 
manuelles au moyen des types d'outils de 
positionnement suivants (suite) :
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Création de cotes (1/2)

A

B

C

D

A

B

C

D

A. Linéaire

B. Angulaire

C. Rayon

D. Diamètre

En utilisant la barre d'outils Dimensions 
(Cotes), vous pouvez créer les types de cote 
suivants :
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Création de cotes (2/2)

E

F

G

E

F

G

E. Chanfrein

F. Filetage 

G. Coordonnées.

En utilisant la barre d'outils Dimensions 
(Cotes), vous pouvez créer les types de cote 
suivants (suite) :
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Cotation d'une longueur

1

2

3

4

Suivez ces étapes pour coter une longueur :
1. Sélectionnez l'icône Length/Distance 

dimensions (Cotations de longueur ou 
de distance) avec l'option Projected
dimension (Cote projetée).

2. Sélectionnez l'arête que vous voulez coter.

3. Sélectionnez la ligne de cote et faites-la 
glisser à l'endroit souhaité.

4. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Cotation d'une distance

2

3

4

1

Suivez ces étapes pour coter une distance :

1. Sélectionnez l'icône Length/Distance 
Dimensions (Cotations de longueur ou 
de distance) avec l'option Projected
dimension (Cote projetée).

2. Sélectionnez la première arête.

3. Sélectionnez la deuxième arête.

4. Sélectionnez la ligne de cote et faites-la 
glisser à l'endroit souhaité.

5. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Cotation d'un trou

2

3

1

4

Suivez ces étapes pour coter des trous :

1. Sélectionnez l'icône Dimensions 
(Cotations) avec l'option Projected
dimension (Cote projetée).

2. Sélectionnez le premier cercle.

3. Sélectionnez le deuxième cercle.

4. Sélectionnez la ligne de cote et faites-la 
glisser à l'endroit souhaité.

5. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Création d'une cote vraie longueur

1

Suivez ces étapes pour coter la longueur 
réelle d'une arête :

4

3

2

1. Sélectionnez l'icône Cotations.

2. Sélectionnez le mode Cotes vraie 
grandeur.

3. Sélectionnez l'élément dans la vue 
isométrique.

4. Sélectionnez la ligne de cote et faites-la 
glisser à l'endroit souhaité.

5. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Cotation d'un angle simple

1 2

3

4

Suivez ces étapes pour coter un angle :

1. Sélectionnez l'icône Cotations d'angle.

2. Sélectionnez la première arête.

3. Sélectionnez la deuxième arête.

4. La cote d'angle est créée. Pour modifier le 
secteur décrit, cliquez avec le bouton droit 
sur la cote et sélectionnez Secteur 
angulaire dans le menu contextuel.

5. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Cotation d'un rayon simple

1

2

3

4

Suivez ces étapes pour coter un rayon :

1. Sélectionnez l'icône Cotations.

2. Sélectionnez le rayon que vous voulez coter. 
La cote apparaît par défaut comme une cote 
de diamètre ; dans ce cas, vous devez la 
changer en cote de rayon.

3. Sélectionnez la cote, cliquez avec le bouton 
droit de la souris, puis sélectionnez Radius 
Center (Rayon radial).

4. Sélectionnez la ligne de cote et faites-la glisser 
pour faire tourner la cote jusqu'à l'endroit 
souhaité.

5. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Cotation d'un diamètre

1

2

3

Suivez ces étapes pour coter un diamètre :

1. Sélectionnez l'icône Cotations de 
diamètre.

2. Sélectionnez le cercle à coter. La cote de 
diamètre apparaît comme indiqué.

3. Sélectionnez la ligne de cote et faites-la 
glisser pour faire tourner la cote jusqu'à
l'endroit souhaité.

4. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Cotation d'un chanfrein

1

2

3

1. Sélectionnez l'icône Chamfer Dimensions 
(Cotations de chanfrein), puis sélectionnez 
le format du chanfrein dans la barre d'outils
Tools Palette (Palette d'outils). 

2. Sélectionnez une ligne ou une surface de 
chanfrein à coter. 

3. Cliquez n'importe où dans le dessin pour 
terminer la création de la cote.

Suivez ces étapes pour coter un chanfrein :
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Cotation d'un taraudage

1

A

B

Les entités de taraudage doivent être 
créées dans le modèle pour créer ce type de 
cote.

Suivez ces étapes pour créer une cote de 
taraudage :

1. Cliquez sur l'icône Cote de taraudage.

2. Sélectionnez la représentation du 
taraudage à coter.

Des cotes de taraudage peuvent être 
créées pour :

A. Vues du dessus. 

B. Vues latérales.
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Cotations chaînées

1
2

3

4

5

1. Cliquez sur l'icône Chained Dimensions.

2. Sélectionnez la première arête.

3. Sélectionnez l'arête suivante.

4. Sélectionnez l'arête suivante. 

5. Sélectionnez l'arête suivante. 

6. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.

Suivez ces étapes pour créer une chaîne de 
cotes :
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Cotations empilées
1

2

3

3

3

1. Sélectionnez l'icône Cotations empilées.

2. Sélectionnez le point ou l'arête d'origine de 
votre système de cotes cumulées. 

3. Sélectionnez tous les autres points ou 
arêtes de votre système de cotes 
cumulées (autant que nécessaire).

4. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.

Suivez ces étapes pour créer des cotes 
empilées :
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Cotations cumulées

1

2

3

34

Suivez ces étapes pour créer des cotes 
cumulées :

1. Sélectionnez l'icône Cotations
cumulées.

2. Sélectionnez le point ou l'arête d'origine 
de votre système de cotes cumulées.

3. Sélectionnez tous les autres points ou 
arêtes de votre système de cotes 
cumulées (autant que nécessaire).

4. Cliquez n'importe où dans le dessin pour 
terminer la création des cotes.
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Propriétés des cotes et numériques

A. Ligne de cote
• Définit l'affichage de la ligne de cote par 

rapport à la cote. 

B. Description de tolérance
• Affiche la cote avec un système de 

tolérance.

C. Tolérance
• Change la valeur de la tolérance pour la 

cote.

D. Description d'affichage numérique
• Affiche la cote dans une unité particulière.

E. Précision
• Définit la précision de la cote.

A B C D E

Vous pouvez contrôler l'affichage des cotes en 
utilisant les barres d'outils Dimension 
Properties (Propriétés des cotes) 
etNumerical Properties (Propriétés 
numériques. Vous pouvez personnaliser les 
zones suivantes de la cote :
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Annotations

A

B

C

D

E

F

A. Texte
• Crée une zone de texte sans ligne repère.

B. Texte attaché
• Crée une zone de texte avec ligne repère.

C. Reproduction de texte
• Crée une copie d'une zone de texte 

existante, et de ses attributs, liée à une 
géométrie.

D. Numéro de pièce
• Crée un numéro de pièce.

E. Référence partielle
• Crée une référence partielle.

F. Modèle de texte
• Place un modèle de texte prédéfini.

Avec la création de cotes dans un dessin, vous 
pouvez ajouter des notes et des annotations. La 
barre d'outils Text (Textes) contient les outils 
suivants :
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Création de vues supplémentaires
Dans cette section, vous apprendrez à créer des vues supplémentaires comme des vues 
de section ou des vues écrêtées.

Suivez ces étapes :

1. Démarrage d'un nouveau 
dessin. 

2. Création de vues.
3. Création de cotes et 

d'annotations.
4. Création de vues

supplémentaires.
5. Modifications de vues.
6. Enregistrement du dessin.
7. Impression du dessin.
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Vues de section et coupes de section 

A. Vue de section : Vue du plan de coupe et toute 
géométrie s'étendant au-delà du plan de 
coupe dans le sens de la vue (flèches). 

B. Coupe de section : Vue uniquement du 
matériau touché par l'arête de découpe 
lorsqu'elle traverse la pièce.

La différence entre une vue de section (décalée 
ou alignée) et une coupe de section (décalée ou 
alignée) est expliquée ici.
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Ajout d'une vue de section simple à un dessin

Suivez ces étapes pour créer une vue de 
section :

1. Activez la vue de face et sélectionnez 
l'icône Section View (Vue de section) 
requise. La vue de face est activée 
lorsque l'axe bleu est visible et que le nom 
de la vue est souligné dans 
l'arborescence. Si l'option de cadre est 
activée, le cadre autour de la vue active 
apparaît en rouge.

2. Cliquez sur A, cliquez deux fois sur B, un 
aperçu s'affiche.

3. Cliquez sur C.

1

A

B

C

2
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Création d'une vue de section à l'aide d'une définition de profil 3D

1. Ouvrez la vue de face et cliquez sur l'icône de 
section voulue (Vue de section ou Coupe de 
section).

2. Accédez à la fenêtre Part, sélectionnez un profil 
pour la définition de la section.

3. Sélectionnez l'emplacement de la vue.

1

2

3

Vous pouvez créer une vue de section en utilisant un 
profil 3D ou un plan 3D comme élément de section.
Utiliser un élément 3D pour définir une vue de section 
permet de contraindre cet élément avec la géométrie 
de la pièce. Le profil de coupe sera modifié
automatiquement si la géométrie de base change.
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�

Ajout d'une vue détaillée

(C)

(B)

(A)

1

2

3

1. Ouvrez la vue de face et cliquez sur l'icône Vue 
détaillée. 

2. Définissez le centre du cercle en cliquant sur (A). 
Cliquez sur (B) pour définir son rayon puis 
déplacez le curseur pour placer la vue détaillée 
sur (C) avec un clic. La vue est générée. 
L'agrandissement par défaut est égal à deux fois 
l'échelle de la vue d'origine.

3. Pour modifier l'agrandissement par défaut de la 
vue détaillée, sélectionnez Properties (Propriétés) 
dans le menu contextuel, puis Parameters
(Paramètres) dans le menu View (Affichage).

Une vue détaillée est définie par un contour 
ajouté à une vue existante. La nouvelle vue 
est créée avec une zone agrandie à l'intérieur 
du contour.
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�

Création d'une vue écrêtée

1

2

3

Les commandes d'écrêtage utilisent 
l'opération booléenne 3D entre la géométrie 
3D et le profil d'écrêtage. Vous pouvez 
écrêter une vue avec un contour circulaire 
(commande Sketched Profile).

1. Activez la vue que vous voulez écrêter. 

2. Cliquez sur l'icône Sketched Clipping 
Profile (Ecrêtage avec profil). 

3. Tracez un polygone fermé autour de la 
zone à conserver.
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Création d'une vue interrompue

1. Cliquez sur l'icône Broken View (Vue 
interrompue).

2. Définissez la zone de rupture en cliquant 
sur (A) à l'emplacement de la première 
ligne de limite de la rupture, puis sur (B) 
pour limiter la hauteur de la zone de 
rupture, puis sur (C) pour localiser la 
deuxième ligne de limite de rupture. 

3. Cliquez n'importe où sur le calque pour 
convertir la vue de section en une vue de 
section interrompue.

Une vue interrompue est définie en ajoutant 
les lignes de rupture qui déterminent une 
zone de la vue à supprimer. 

La deuxième limite de rupture 
peut être n'importe où dans la 
zone désignée par la ligne verte 
discontinue. 

(C)

(A)

La ligne rouge continue 
représente la zone qui ne peut 
pas être sélectionnée pour créer 
la deuxième limite de la rupture.

(B)

1

2

3

Une vue peut contenir plusieurs définitions de 
rupture à condition que chaque définition aille 
dans la même direction et que les ruptures ne 
se chevauchent pas.
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Création d'une vue écorchée

Profil de l'écorché

1

2

3

1. Activez la vue de droite et cliquez sur 
l'icône Breakout View (Vue écorchée).

2. Créez le profil de l'écorché. Cliquez deux 
fois sur le premier point pour fermer le 
profil.

3. La fenêtre 3D Viewer apparaît. Faites 
glisser et déposez la ligne continue orange 
pour obtenir le plan sécant requis.

4. Cliquez sur OK dans la fenêtre 3D Viewer. 
L'écorché est créé.

Une vue écorchée permet de créer une 
section locale (par un plan) pour voir à
l'intérieur d'une pièce sans la sectionner en 
totalité.
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Ajout d'une vue auxiliaire

(A)

(B)

1

2

3

1. Activez la vue et cliquez sur l'icône 
Auxiliary View (Vue auxiliaire). 

2. Tracez la représentation du plan (A) ou 
sélectionnez une arête (B) sur le dessin et 
faites glisser le curseur pour afficher 
l'aperçu de la vue auxiliaire.

3. Cliquez n'importe où sur le dessin pour 
créer la vue auxiliaire.

Une vue auxiliaire est un type de vue créé
dans une direction donnée, ne pouvant pas 
être obtenue à l'aide d'une vue standard.
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Modifications de vues
Dans cette section, vous apprendrez à modifier des définitions de vue et à gérer le 
contenu d'une projection de vue.

Suivez ces étapes :

1. Démarrage d'un nouveau 
dessin. 

2. Création de vues.
3. Création de cotes et 

d'annotations.
4. Création de vues

supplémentaires.
5. Modifications de vues.
6. Enregistrement du dessin.
7. Impression du dessin.
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Repositionnement des vues (1/5)

• Set Relative Position (Positionner de façon 
relative).

• Position Independently of Reference View
(Positionner indépendamment de la vue de 
référence).

• Superpose (Superposer).

• Align Views Using Elements (Aligner des 
vues à l'aide d'éléments).

Vous pouvez modifier la position d'une vue après 
l'avoir placée dans le dessin. Sélectionnez le cadre 
de la vue pour le déplacer vers une autre position. 
La vue de projection est contrainte par sa vue 
parent. 

Outre la possibilité de faire glisser et déposer des 
vues, vous avez quatre autres méthodes pour les 
repositionner :
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Repositionnement des vues (2/5)

2

3

4

1. Activez la vue que vous voulez 
déplacer.

2. Cliquez avec le bouton droit de la 
souris sur le cadre de la vue et 
sélectionnez Set Relative Positioning
(Positionnement relatif). Une droite 
de positionnement de direction 
apparaît dans la vue.

3. Sélectionnez le point noir de référence 
de la droite de direction, ce symbole se 
changera en une extrémité rouge 
clignotante jusqu'à ce qu'un autre point 
soit sélectionné comme point de 
référence.

4. L'extrémité verte de la droite de 
direction peut être déplacée en 
différents points d'ancrage de la vue ou 
déplacée librement.

L'option Set Relative Positioning
(Positionnement relatif) vous permet de 
déplacer une vue sur la base de sa 
position relative par rapport à différents 
éléments (ex. point, droite, cadre). 

Suivez ces étapes pour repositionner une 
vue en utilisant cette option :
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Repositionnement des vues (3/5)

2

1

Déplacement d'une vue de projection 
dépendante. 

Déplacement d'une vue de 
projection indépendante. 

3

1. Activez la vue que vous voulez 
déplacer.

2. Cliquez avec le bouton droit de la 
souris sur le cadre de la vue et 
sélectionnez Position 
Independently of Reference View
(Positionner indépendamment de la 
vue de référence).

3. Faites glisser et déposez la vue.

L'option Position Independently of 
Reference View (Positionner 
indépendamment de la vue de référence) 
vous permet de repositionner une vue 
sans qu'elle soit contrainte par sa vue 
parent.

Suivez ces étapes pour repositionner une 
vue en utilisant cette option :
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Repositionnement des vues (4/5)

1

2

3

1. Activez la vue que vous voulez 
déplacer.

2. Cliquez avec le bouton droit sur le 
cadre de la vue et sélectionnez 
Superpose (Superposer).

3. Sélectionnez la vue sur laquelle vous 
voulez superposer la première vue.

L'option Superpose (Superposer) vous 
permet de superposer une vue sur une 
autre. 

Suivez ces étapes pour repositionner une 
vue en utilisant cette option :
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Repositionnement des vues (5/5)

2

3

4

1

1. Cliquez avec le bouton droit sur le 
cadre de la vue et sélectionnez Align
Views Using Elements (Aligner des 
vues à l'aide d'éléments).

2. Sélectionnez dans la vue une arête 
avec laquelle vous voulez aligner.

3. Sélectionnez une arête dans la vue 
que vous voulez aligner avec la vue 
précédente.

4. La vue se déplace en conséquence. 
Dans cet exemple, les vues sont 
alignées sur l'arête d'une pièce.

L'option Align Views Using Elements
(Aligner des vues à l'aide d'éléments) 
vous permet d'aligner une vue avec une 
autre vue sur la base d'une géométrie 
similaire entre elles deux. 

Suivez ces étapes pour repositionner une 
vue en utilisant cette option :
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Suppression de vues

A

B

A. Sélectionnez le menu Edit > Delete (Edition > 
Supprimer) pour supprimer les vues sélectionnées.

B. Sélectionnez Delete (Supprimer) dans le menu 
contextuel.

C. Appuyez sur la touche <Suppr> du clavier pour 
supprimer les vues sélectionnées.

Les vues peuvent être sélectionnées à partir de l'arbre 
des spécifications ou directement à partir du dessin. 

Une fois que vous avez sélectionné les vues que vous 
voulez supprimer, utilisez l'une des méthodes suivantes 
pour les supprimer :
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Propriétés des vues
1

2

3

1. Cliquez avec le bouton droit sur une vue dans 
l'arbre des spécifications ou dans le cadre de la 
vue. Cliquez sur Propriétés (Propriétés) dans 
le menu contextuel. La fenêtre Properties
(Propriétés) apparaît.

2. Utilisez les onglets View (Vue) et Graphic
(Graphique) pour modifier les options requises. 
Les 
propriétés suivantes sont modifiées dans 
cet exemple :

a. View name (Nom de la vue).
b. Fillets (Congés d'arête) dans les éléments 

de dress-up (habillage).
c. Visualization (Visualisation) pour retirer le 

cadre.
3. La vue est modifiée comme suit.

Suivez ces étapes pour modifier les propriétés 
d'une vue :
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Modification des liens d'une vue (1/2)

3

1

Vous pouvez modifier le contenu d'une 
vue au moyen de la commande Modify
Links (Modifier les liens). Suivez ces 
étapes pour modifier les liens :
1. Activez la vue que vous voulez modifier 

puis sélectionnez Modify Links (Modifier 
les liens) dans le menu contextuel. 

2. Accédez au fichier de produit référencé par 
la vue.

3. Sélectionnez dans l'arbre de spécifications 
tous les composants que vous souhaitez 
projeter.
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Modification des liens d'une vue (2/2)

Les composants 
sélectionnés s'ajoutent à
la liste des éléments 3D à
ajouter.

Aperçu des 
composants
sélectionnés

5

6

5

4. Accédez à nouveau au fichier 
CATDrawing. 

5. Sélectionnez Add all (Ajouter tout) et 
cliquez sur OK.

6. Mettez à jour le dessin.

Pour modifier les liens, procédez comme suit : 
(suite)
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Remplacement du plan de projection d'une vue (1/2)

Vous pouvez modifier la définition du plan de 
projection d'une vue de face, d'une vue 
isométrique ou d'une vue 3D. Pour remplacer le 
plan de projection, procédez comme suit :

1. Activez la vue puis sélectionnez Modify
Projection Plane (Modifier le plan de 
projection) dans le menu contextuel. 

2. Accédez au document de pièce qui contient 
la géométrie de référence.

3. Sélectionnez le nouveau plan de projection.

3

1
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Remplacement du plan de projection d'une vue (2/2)

4

5

4. Modifiez la définition de la vue à l'aide du 
manipulateur et positionnez la vue. 

5. Mettez à jour le dessin pour propager les 
modifications à toutes les vues 
secondaires de la vue modifiée.

Vous devez repositionner les vues secondaires. Pour 
répercuter les modifications, vous pouvez utiliser la 
commande Synchronize View Definition
(Synchroniser la définition de la vue) disponible dans 
le menu contextuel des vues de section et détaillées.

Pour remplacer le plan de projection, 
procédez comme suit (suite):
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Inversion du profil de vue de section

1

2

3

1. Cliquez deux fois sur le profil de la vue de 
section pour ouvrir la barre d'outils 
d'édition/remplacement‘Edit/Replace', 
permettant d'apporter un certain nombre de 
modifications.

2. Inversion du sens de la vue : cliquez sur 
l'icône Inversion de la direction du profil.

3. Cliquez sur l'icône Exit (Sortir) pour 
appliquer les modifications.

Vous pouvez inverser la direction du profil de 
section à l'aide de la barre d'outils Edit/Replace 
(Edition).
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Remplacement du profil de vue de section
1

2
3

1. Cliquez deux fois sur le profil de la vue de section pour 
ouvrir la barre d'outils ‘Edit/Replace' permettant 
d'apporter des modifications.

2. Sélectionnez l'icône Replace Profile (Remplacer le 
profil). Créez un nouveau profil qui remplace l'ancien.

3. Sélectionnez l'icône End Profile Edition (Sortie du 
mode d'édition) pour appliquer les modifications.

Vous pouvez remplacer le profil de section par 
un nouveau profil à l'aide de la barre d'outils 
Edition.
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Enregistrement d'un dessin
Dans cette section, vous apprendrez à enregistrer un dessin.

Suivez ces étapes :

1. Démarrage d'un nouveau 
dessin. 

2. Création de vues.
3. Création de cotes et 

d'annotations.
4. Création de vues

supplémentaires.
5. Modifications de vues.
6. Enregistrement du

dessin.
7. Impression du dessin.



Notes de l'étudiant:
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Mise en correspondance du dessin avec la pièce 3D modifiée

6040

Avant d'enregistrer un dessin, vérifiez qu'il est mis 
à jour avec les informations les plus récentes. Si 
l'icône Update (Mise à jour) est en surbrillance, 
cela signifie que le dessin doit être mis à jour pour 
refléter les modifications effectuées sur le modèle 
3D correspondant. Par exemple, la largeur de la 
pièce ci-dessous est passée de 40 à 60 (mm). Si 
vous sélectionnez l'icône Update (Mise à jour), la 
vue est régénérée avec les nouvelles cotes.
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Vérification des liens à des pièces 3D (1/2)

1

1. Sélectionnez le menu Edit > Links 
(Edition > Liaisons) dans la barre de 
menus, comme indiqué.

2. La pièce référencée manque à toutes 
les vues du dessin.

Il est possible qu'un dessin soit ouvert sans 
ses documents de référence chargés en 
session - cela peut être dû à un fichier ou à
un paramètre global de CATIA manquant -
l'arborescence l'indique avec des icônes 
«cassées». 
Afin que soit mis à jour correctement le 
dessin, ses liens doivent être vérifiés.

Suivez ces étapes pour charger un 
document manquant lié à une vue :
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Vérification des liens à des pièces 3D (2/2)

3

4

2
3. Sélectionnez l'onglet Pointed

Documents (Documents
pointés).

4. Sélectionnez le bouton Load
(Charger) pour charger la 
pièce.

5. Mettez à jour le dessin.

Suivez ces étapes pour charger 
un document manquant lié à
une vue (suite) :
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Enregistrement d'un dessin

Vous pouvez enregistrer un dessin comme 
tout autre fichier CATIA. Vous pouvez aussi 
utiliser les commandes Save As (Enregistrer 
sous)et Save Management (Gestion des 
enregistrements) pour stocker le dessin. 
Souvenez-vous qu'un dessin est dépendant 
des pièces 3D qu'il représente ; il est donc très 
important de vérifier que les pièces et le 
dessin sont mis à jour avec les informations 
les plus récentes.



Principes de base CATIA V5- Leçon 10 : Drafting (ISO)
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                          10-87

Impression d'un dessin
Dans cette section, vous apprendrez à imprimer un dessin.

Suivez ces étapes :

1. Démarrage d'un nouveau 
dessin. 

2. Création de vues.
3. Création de cotes et 

d'annotations.
4. Création de vues

supplémentaires
5. Modifications de vues
6. Enregistrement du dessin.
7. Impression du dessin.
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Impression d'un dessin

Cliquez sur le menu Fichier > Imprimer ou 
sélectionnez l'icône Imprimer directement 
pour imprimer votre dessin. Le contenu de la 
fenêtre Print (Imprimer) vous permet de 
personnaliser la disposition, la mise en page et 
les options. Elle affiche aussi Print Preview
(Aperçu) du dessin.
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Interface utilisateur d'impression (1/2)

A

B C

D
E

Onglet 'MultiDocuments'

A. Printer (Imprimante)

• Sélectionnez une imprimante ou entrez 
le nom du fichier de l'imprimante.

B. Position and Size (Position et taille)

• Définissez la position et la taille de la 
géométrie sur la page.

C. Print Area (Zone d'impression)

• Définissez la zone à imprimer.

D. Page Setup (Mise en page)

• Définissez la taille et les caractéristiques 
de la page.

La fenêtre Print (Imprimer) contient les 
informations suivantes, que vous pouvez 
modifier :
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Interface utilisateur d'impression (2/2)

E. Options d'impression

• Color (Couleur)

• Banner (Bannière).

• Various (Divers).

La fenêtre Print (Imprimer) contient les 
informations suivantes, que vous pouvez 
modifier (suite) :
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Pour résumer...

� Création d'un nouveau dessin
� Insertion d'un cartouche
� Création de vues élémentaires
� Cotation et annotation 
� Enregistrement et impression.

En utilisant les connaissances acquises dans cette 
leçon, vous devez être capable de créer le dessin de 
la pièce de base.

Le dessin nécessite les étapes suivantes :



Notes de l'étudiant:
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Exercice : Création d'un dessin
Exercice : Récapitulatif

20 min

Dans cet exercice, vous utiliserez vos nouvelles acquisitions pour créer le dessin 
d'un boîtier de CD.  Vous recourrez aux outils utilisés dans les précédents exercices 
pour réaliser cet exercice sans instructions détaillées. 

A la fin de cet exercice, vous serez capable de :

� Créer un nouveau dessin

� Insérer un cartouche

� Ajouter des vues

� Coter et annoter le dessin

� Enregistrer le dessin
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�

C'est à vous !  

1. Créez le dessin de la partie inférieure du boîtier de CD, comme indiqué.
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�

Récapitulatif de l'exercice : Création d'un dessin

� Création d'un nouveau dessin

� Insertion d'un cartouche

� Ajout de vues

� Cotation et annotation du dessin

� Enregistrement du dessin
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Etude de cas : Drafting
Exercice : Récapitulatif

20 min

Vous allez mettre en pratique ce que vous avez appris en réalisant le modèle de 
l'étude de cas : seuls un dessin détaillé et des conseils seront à votre 
disposition pour vous guider.

Dans cet exercice, vous créerez le dessin du modèle d'étude de cas.  Gardez en 
mémoire l'objectif de conception du modèle :
� Le dessin doit être créé en utilisant une norme ANSI.

� Le dessin doit contenir une vue affichant les lignes cachées et les axes.

� Le dessin doit contenir un cartouche.

En utilisant les techniques apprises dans cette leçon et les 
précédentes, créez le modèle sans instructions détaillées.
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C'est à vous : Dessin de la pièce de base
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�

Étude de cas : Pièce de base (récapitulatif)

� Le dessin doit être créé en utilisant une norme 
ANSI.

� Le dessin doit contenir une vue affichant les 
lignes cachées et les axes.

� Le dessin doit contenir un cartouche.




